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Letter of Introduction from the 
Directors of Oxford Learning College 

 

Dear Student, 

 

We would like to take this opportunity to warmly welcome 
you to your course. At Oxford Learning College, we seek to 
ensure that all students have an enjoyable and productive 
relationship with the College, grow both academically and 
personally and leave satisfied. 

By enrolling and taking responsibility for your learning, you 
have started on a path that will interest and challenge in 
equal measures and allow you to develop, grow and leave 
with knowledge and skills that will be of great use to you in 
the working environment.  

 

We wish you the best of luck on your journey!   

 

Darren Wood and Deborah Coombe 
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Chapter 1: Getting Started 

 

 

 

 

 

 

This section will give you a brief overview of how your course runs and 
important information that you need to know before you start. Later in the 
handbook, there will be more detailed sections. 

As you prepare your plan for studying and further for submitting an 
assignment, you need to read the handbook again as there is valuable 
advice here to help you succeed.  

Your learning and completion of your course remains your responsibility, 
including the liaising with your tutor and the planning and submitting of work at 
regular times during your course.  However, the level of support can often be 
restricted, in order to adhere to Awarding Body policies. 

Getting in touch with Student Services  

Most students will already have spoken to student services during the 
enrolment process. Remember, Student Services are here to help you! If you 
have any problems with your account, and payment of course fees or any 
technical issues, Student Services is your first point of contact except for 
questions of an academic nature regarding your course. 

If your question is academic related, you will need to communicate with your 
tutor directly as she/he will be the expert in terms of the academic content of 
your course and materials. It is the requirement of the Awarding Bodies that 
qualified Academic professionals are to provide all levels of academic advice.   

You can contact Student Services between 9AM and 5PM (GMT) from Monday 
to Friday. If you leave a message outside of these times, Student Services will 
get back to you as soon as possible on the next working day. The quickest way 
to get in touch with student services is to use the following methods: 

➢ Telephone 01865 595 263 
➢ ‘Ask A Question’ Link on Campus 

All telephone calls to and from Student ~Services are recorded for training 
purposes. 

Important Notice: This handbook is required reading for all students. 

This handbook has been written to help you settle into your course and get 
started. You should check the handbook regularly for updates; the cover page 
indicates the date of last revision.  Updates will be uploaded on the system for 
students to have access. 
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Software  

You are not required to have any specialised software to complete your course. 
Course materials can be accessed by any standard web browser. We 
recommend that you use Mozilla Firefox, Google Chrome or Internet Explorer, 
ensuring you have the latest version installed. We cannot guarantee course 
materials will run correctly on other lesser known browsers. 

Your assignments need to be uploaded in Microsoft Word format, either .doc 
or .docx; any other format will not be accepted when you upload your work. If 
you do not have Word, or would prefer not to use it, then you can use a free 
alternative, such as Libre Office or Apache Open Office, both of which can save 
documents in the required Microsoft Word format. 

If you have chosen to order a copy of your Course Materials in PDF, you will 
need to use either Adobe Digital Editions or BlueFire Reader to access the 
PDF. Please kindly note, the PDF version of your course will be restricted to 
use on one device and will not be printable. 

The Accredited Courses in brief 

Most of the courses offered are accredited by the Centre for Interactive 
Education (CIE) Global; see http://www.cieglobal.co.uk. The courses will 
consist of a number of units, and in general you will be asked to complete one 
or two assignments for submission to your tutor for marking. Please note, when 
you view the CIE Global website, don’t be alarmed if you don’t see your course 
listed.  This will be because many of our courses are Accredited by the CIE as 
“customized” courses, written in a way for on-line students.  

Course Duration 

Your course life begins as soon as your log-in details have been sent to the e-
mail address provided in your enrolment. Once your course has expired, your 
account will be disabled. Please see the following table: 
 

 

Accredited Level 2 Diploma 
Unlike GCSE courses, our one-year Accredited Level 2 Diploma courses do 
not require any examinations. Instead, they are studied entirely online through 
our unique learning environment. You are free to study the course materials at 
your own pace and submit required assignments as and when it best suits you. 
These course entails two pieces of coursework. 
 

Course Duration 

Level 2 Diploma 1 Year 

Level 3 Diploma 1 Year 

http://www.cieglobal.co.uk/
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Your work is ultimately graded on a Pass or Fail (Referred) criteria.  
 
Further to flexibility, these courses carry 120 Academic credits which can be 
put towards entry requirements for higher-level studies. These are not UCAS 
points but are equivalent to them and recognised by many Universities and 
Colleges.  
 
The respective awarding body for this type of course is C.I.E. GLOBAL (The 
Centre for Interactive Education). 

Accredited Level 3 Diploma 
Unlike A-Level courses, our one-year Accredited Level 3 Diploma courses do 
not require any examinations. Instead, they are studied entirely online through 
our unique learning environment. You are free to study the course materials at 
your own pace and submit required assignments as and when it best suits you. 
These course entails two pieces of coursework. 
 
Your work is ultimately graded on a Pass or Fail (Referred) criteria. Please note 
that you will only be able to submit your two pieces of work the one time each.  
 
Further to flexibility, these courses carry 120 Academic credits which can be 
put towards entry requirements for higher-level studies. These are not UCAS 
points but are equivalent to them and recognised by many Universities and 
Colleges.  
 
The respective awarding body for this type of course is C.I.E. GLOBAL (The 
Centre for Interactive Education). 
 

Quality Assurance 

On a regular basis, our tutors are monitored in terms of assessment feedback 
and support provided to students, to ensure consistency with Awarding Body 
and the College requirements and fairness to students.  There may be times 
when randomly your assignment work, once marked by your tutor, will be 
looked at further by our Internal Verifier (IV).  The IV will deal directly with your 
tutor and the College so you are unlikely to hear from him/her.  Anything you 
need to be notified about will come from your tutor. 
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Chapter 2: Using Campus – Your on-line environment 

Campus is Oxford Learning College’s Virtual Learning Environment (VLE). 
Campus is where most your time studying will be spent and is where you 
access your course materials and contact your tutors. You can see a 
screenshot of the Campus homepage below and a brief overview of the main 
features: 

 

Figure 1 - Screenshot of Campus 

➢ My Courses – This is where you will find your course and assessment 
materials 

➢ Upload Assignments – This is where you will upload your end of unit 
assignments and download your completed assignments with tutor 
feedback 

➢ Ask A Question – This is where you can message Student Services and 
your Tutor. You will receive an email notification when your message is 
responded to and can come back to the message thread to continue 
your discussion. 

➢ Schedule – This is your course planner. Come here to plan your studies, 
set dates for assignments and check to see if you are running on 
schedule. 

➢ Noticeboard – Here you’ll see important messages from Student 
Services and your Tutors, so be sure to check it regularly. 



Level 2 and Level 3 ACCREDITED DIPLOMA STUDENT HANDBOOK 

June 1, 2017, v2 

 
 

 

Page 8 of 28 
 

 

Contacting your Tutor 

You can contact your tutor, using the Ask a Question link. When you send a 
message to your tutor, it opens a message thread that you can come back to 
review your responses. You will also get an email notification when your tutor 
responds back to you. Make sure you log into Campus to respond, as tutors 
cannot contact you via email. 

The messages threads will remain open for the duration of your course, so you 
can refer to them at any point. 

We recommend you contact your tutor in the first instance, just to introduce 
yourself.  Do this by using the Ask a Question link.  

Asking for help 

We are here to help! If you have any problems at any point during your course, 
you can contact us for assistance. Student Services and your Tutors are on 
hand to help you, but have distinct and separate roles. To help you get help 
quicker, please see the following breakdown of who to contact: 

Tutors should be contacted for the following reasons:  

➢ Academic Questions about course materials 
➢ Questions about assignments 
➢ Guidance on the course 

Student Services should be contacted for the following reasons:  

➢ Technical problems  
➢ Fee payments  
➢ Password/login issues  
➢ Course material glitches, eg typos.  
➢ Change of circumstances/address/contact details 
➢ Referencing Assistance 

Portfolio 

Students are required to keep a digital portfolio throughout their time on the 
course.  

Its purpose is to give your studies a central reference point and it may be 
requested by the College or your Tutor at any point during your course.  A 
portfolio can be expanded to your needs, but should contain the following as a 
minimum: 

➢ Course notes copies 
➢ Copies of your assignments 
➢ Copies of your annotated assignments, when returned by your tutor 
➢ A reference list 
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Assignments 

To complete your course, you must complete all assignments in consecutive 
order.  

There are several different formats for assignments. You will find specific 
instructions for each assignment in your course documents.  

Your work will be scanned for plagiarised content and, if plagiarised content is 
found to exceed 10% of the total content of the assignment your work may be 
marked as a referral/fail.  

Deadlines 

We do not set deadlines for student to have completed their assignments. 
However, we strongly encourage students to work with their tutors to develop 
realistic, self-imposed deadlines. You can use the study planner (see schedule 
icon) to set your deadlines, track your progress and schedule study and 
assignment writing sessions.  There is further planning advice later in this 
handbook for you. 
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Chapter 3: Working with your Tutor 

 

You will have support throughout the duration of your course from your tutor, 
who has a great deal of experience and knowledge in the subject matter. All 
Oxford Learning College Tutors are trained in delivering distance learning 
courses and will be able to assist you. 

What your tutor can do for you 

Your tutor can provide advice on how to help you work through the course 
materials, answer your questions, and guide you through challenging concepts.   

What your tutor can’t do for you 

Your tutor cannot plan or complete your assignments for you, in part or in 
whole. They cannot proofread your assignments prior to submission and 
cannot simply “give you the answers”.  

How to make the most of your tutor interaction 

When contacting your tutor, you will get the best results and quickest 
responses if you can format your question in a clear, concise manner that 
allows your tutor to see exactly what you are struggling with. 

If you are stuck on something, before contacting your tutor try working through 
the course materials that cover the concept before sending the question. If you 
are still stuck, then ask your tutor for help, making sure to include the following 
in your message: 

➢ Unit Number 
➢ Page numbers (If applicable) 
➢ Your question 
➢ An explanation of your understanding of the topic (to allow your tutor to 

identify any errors and check your progress) 

The reason we ask for these details is to allow your tutor to answer to your 
question as directly and as quickly as possible, which minimizes the time 
before you can progress on your course. Consider the following two questions. 

Question 1. 

Hi, I don’t really understand Business Management, can you help? 

Thanks, Student A 

Question 2. 

Hi, I don’t understand how Ansoff’s concepts of management might not apply to a 
modern global business, as indicated on page 200, Unit 1 of the course materials. Can 
you help? 

Thanks, Student B 
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The first question lets the tutor know that you need help, but requires the tutor 
to ask a number of questions before they understand what you need help with, 
to which you will have to respond before they can answer your question. This 
delay means they cannot help you to progress at an optimal pace. 

The second question is much better, because it lets the tutor know exactly 
where you are, which concept you are working on and why you are having 
difficulties with it. This means their response can be directed at your question, 
so you will receive an answer much more quickly and you can move on in your 
studies. 

Appropriate contact with your tutor 

Oxford College takes interaction between students and Tutors very seriously 
and regularly reviews messages to ensure that standards are being maintained 
and to check that all contact is appropriate. All messages are logged and saved 
on Campus. 

Oxford College requires all parties to be polite, respectful and courteous at all 
times and will not tolerate rude, offensive or discriminatory language. 

Students are not permitted to share contact details or to contact tutors outside 
of the College messaging system. Tutors are instructed to ignore messages 
from students that are not from the Campus system. 

In the rare event that the Campus messaging system is unavailable, student 
services will facilitate communications between tutors and students. 
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Chapter 4: Planning your studies 

 

Introduction 

To make the most of your time on the course and to help you achieve the best 
possible results, we strongly advise students to take time at the start of the 
course to carefully develop a study plan. 

Plans can range from simple target dates for completion of units, to very 
specific breakdowns and timetables of daily study. There is no one-size-fits-all 
plan, you will need to work out which plan works best for you.  

As a rule of thumb, if you are highly self-motivated or have extensive 
experience in the area of study, you can use a simpler plan. If you find that you 
struggle to motivate yourself, or find it difficult to concentrate, then you may 
benefit from a more detailed timetable. We’ll go into detail on how to create a 
variety of plans shortly. 

What to consider when planning 

The key points to consider when planning are: 

➢ Length of course 
➢ Study time suggested to you 
➢ Assignments 
➢ Tutor marking time and quality assurance time – can be up to 1 month  

When setting out your plan, you should ensure that you are realistic when 
setting goals. You may want to throw yourself into the course headfirst – and 
we in no way want to discourage your enthusiasm! – but you should consider 
if you can sustain the initial rate of work.  

Using the Study Planner software 

When logging into campus, you will see a link entitled ‘Schedule’. This is the 
Campus study planner and comes complete with a skeleton plan laid out for 
you. This plan and the dates are recommended, but you are free to adjust them 
to your needs. 
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Chapter 5: Studying 

This section is an overview of how you will be studying your course materials. 
All students learn differently, so not all parts will be suitable for your personal 
requirements. However, this section outlines ‘best practices’, which will be 
beneficial in part or whole for most students. 

Remember that your notes will form part of your course portfolio, which may 
be requested by the College or your Tutor. Your portfolio can also be used as 
part of your Continuous Development Plan (CPD). 

Study environment 

Whenever possible, you should try to set aside a designated study environment 
in which you are able to focus entirely on your studies. Some of the key features 
you should aim to achieve with your study environment are: 

➢ Quiet – If you can find a quiet spot in your home, that is relatively 
isolated, you will find that focusing on your course will be easier than 
when in an environment where you are being interrupted. It’s fine to 
have music playing, provided that you don’t get distracted. If finding 
somewhere quiet in your home isn’t possible, then consider going to a 
local library, or similar quiet space where you can work in peace, 
 

➢ Minimise interruptions – Try to make sure that you won’t be disturbed 
when you are studying. Interruptions don’t just mean having a noisy 
household, but also include other forms of distractions, such as social 
media notifications, phone calls or texts, television etc... The easiest 
way to deal with this is to turn your phone OFF. Unless you have an 
urgent need to have your phone on, it will prove a distraction. Stay 
logged out of social media sites and switch off the TV. 
 

➢ Make your study environment a single purpose environment - This 
means that your study space is set aside for no other purpose but to 
study. By doing so, you will ensure that you associate the environment 
with studying and will be able to focus on the task at hand much more 
quickly, thus minimising wasted time. Granted, this isn’t always possible 
in terms of physical space, but you can employ the same principles to 
other aspects of studying. For example, when studying online, you 
should shape your online environment along the same lines. Only visit 
websites relevant to your studies, keep out of Twitter or Facebook.  
 

➢ Comfort – Making your study area comfortable will mean that you will 
be less distracted and will be able to turn all your attention to the task at 
hand. Before you start your study session, assemble all the things you 
will need to enable you to study uninterrupted, such as a cup of tea, 
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snacks, blanket etc. Having these to hand will mean you will be 
comfortable and don’t need to start studying. 
 

➢ Lighting – Whilst natural light is the best option, it isn’t always possible 
to have the benefit of it. Ensure that you have adequate lighting and are 
not having to squint to study. 

Study methods 

Throughout the duration of your course, it is recommended that you make the 
most of your studies by using study tools to help your learning process.  
Remember, regardless of whether you prefer low tech pen and paper or a high 
tech digital method, backing up your notes is essential. If you keep paper notes, 
creating a duplicate set can be a great revision exercise and having a separate 
copy will mean that if your notes are lost or damaged, you have a back-up set. 

Likewise, if you prefer digital notes, having a backup of your notes is essential. 
Regularly back up your notes to a spare memory stick or use a cloud service 
such as Dropbox or Evernote 

Making notes is mandatory for online learning, but ensure that the notes you 
make are useful.  

At Oxford Learning College, all study materials are presented in written format, 
either online or in Paper/PDF form. You will be required to read through the 
materials and carry out additional research or self-assessment exercises 
where directed to do so in the text. 

Pen and Paper 

The simplest tool that you will use and probably the most common, making pen 
and paper notes is how most students start learning.  

When making notes, you should make sure that your notes are clear and 
detailed, but concise. Beware of excessive note taking, as this can be 
counterproductive. You do not want to find yourself copying out the course 
materials verbatim. 

A good idea is to review your notes regularly and re-write them in a clearer and 
easier to read format. As well as making your notes more useful and 
accessible, you will also find that you are revising the course topics as you go. 

Students commonly use highlighters to select sections of interest. While this 
can be useful to direct your attention to important parts, it is best used in 
moderation. 

Flowcharts 

Flowcharts are best used to demonstrate a linear process and can be useful 
as learning tools because they allow you to breakdown a process step-by-step 
until you have retained the information. 

https://www.dropbox.com/
https://evernote.com/
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Mind maps 

Mind maps are a flexible visual tool, allowing you to split complex concepts into 
simpler sections or link different subjects together. A particularly good tool for 
visual learners, Mind maps can be used as part of a brainstorming session, 
revision exercise or summary of a Unit. They are also particularly useful in 
helping to plan an assignment by letting you see a visual representation of the 
concepts you need to include. 

 

 

Figure 2 - Example of a Mind Map. Source: Wikimedia 

 

Flashcards 

Flashcards are small cards that can be bought from stationers or made at 
home. They are designed to be used to create extremely concise notes for 
reference and revision purposes. Best used in short sessions, flash cards let 
you go over important topics in a short space of time, meaning that you can 
carry out micro study sessions when you have five minutes to spare. They can 
also be useful when working on an assignment, to remind you of the key points 
you need to make. 

 

 

 

Sources 

 

There are a wide variety of study methods open to you and not all of them will 
prove effective for your style of learning. It is strongly advised that you establish 
the method of study that works best for your needs and review it regularly to 
make sure that you are getting the most benefit. 
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Chapter 6: Assignments 

 

Understanding assignments 

The first steps of completing an assignment should always be: 

➢ Read and understand what is expected of you/what you are being asked 
for. 

➢ Read and understand the course materials. 
➢ Research the topic thoroughly. 
➢ Plan your assignment. 

 

Types of assignment 

There are a number of formats in which you might be asked to present your 
assignment. The most common formats are assignment and reports. Both 
academic assignments and reports require the same planning and research, 
even though the final format is different. 

How to complete an assignment 

Researching  
The first step on completing an assignment is to research the question and 
topic. 

Ensure that you understand what the question/instruction is asking. Look 
carefully at the way the question is written. Ask your tutor if there any 
instructions that you don’t understand.  This could be when you’re, for example, 
if you are asked to “analyse” or “comment upon” which could mean different 
things. 

Once you fully understand what the question is asking of you, it is time to begin 
your preparation. You will need to find information relevant to the question that 
you have been posed. 

Before you start looking for information, think about how you would find 
information that is relevant to your question. Make a list or mind map of how 
you want to approach the question and what information you require to answer. 

Remember, as you research you may find that the focus of your assignment 
alters as you find new information. This is fine so long as your assignment still 
answers the questions that you have been set. 

Your research materials can come from a wide variety of sources including 
books, magazines, journals, newspapers, television and websites. Details on 
how to reference these can be found later. 
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Planning an assignment 
Once you have done your initial research, you should think about planning your 
assignment. Every assignment should have an initial plan, even if you find that 
you diverge from it at a later point. 

Plans can be visual – in the form of tables, illustrations or diagrams – or they 
can be written. Find the style that suits your needs best. Your plan has 2 
purposes. Firstly, it should act as a checklist, to ensure you don’t miss out any 
important parts. Secondly, it should give you an idea of the initial structure of 
the assignment itself. 

Writing an assignment 
When you write, you need to ensure that your writing follows these key points: 

➢ Uses clear, correct language. 
➢ Uses correct terminology. 
➢ Uses technical language where needed. 
➢ Does not use excessively wordily words for the sake of it. 
➢ Use British spelling where possible. 
➢ Harvard Referencing System (HR) to be used throughout your work. 

By writing in a specific and consistent style, your assignment will be much 
easier to read and evaluate. Using clear, straightforward language means that 
your argument will be easier to follow and understand. Using the correct 
terminology, as well as technical terminology is expected, but take care not to 
use excessively complex language for the sake of it. Aside from adding to your 
limited word count, it will not benefit your grade, but misusing complex 
language may make it harder to understand your point. 

 

 

 

 

 

 

1st Vs 3rd Person 
Generally, you will be expected to write in the 3rd Person. This means that you 
should avoid phrases like we, you and us. Instead you should be using phrases 
like he, she, it, they, him, her and them. 

Example: 

1st Person - “In this assignment, I will examine how theories of business 
management have developed over the last 2 years.” 

3rd Person - “Business management theories have changed over the last 2 
decades, with a variety of a different approaches emerging.” 

Tutors and Assessors are Human too! 

Remember that your assessor does not want you to fail. However, they do 
have to read through many assignments each week. By following the above 
guidelines, you can ensure that they find your work easier to read and 
understand. 
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Formatting  
The specific format of your work is relatively open, as the only restrictions are: 

➢ It must be saved in an MS Word format. 
➢ It should be written in blue or black fonts. 
➢ It should be easy to read. 

You will want to ensure that your work is presentable and most importantly, 
easy for your assessor to read. We suggest that you use a standard font, such 
as Arial, Calibri or Times New Roman. Do not use fonts that would appear 
unprofessional, or are hard to read. Assignments should be written in size 11 or 12 

fonts and double spaced unless otherwise stated. 

Make use of paragraphs to break your assignment up into easy to read chunks. 
This will make it easier for your Assessor to read. In reports, headings and sub-
headings should be used where necessary. 

When it is relevant, you may include visual images. On the Insert tab, the 
galleries include items that are designed to coordinate with the overall look of 
your document. You can use these galleries to insert tables, headers, footers, 
lists, cover pages, and other document building blocks. When you create 
pictures, charts, or diagrams, they also coordinate with your current document 
look. You can easily change the formatting of selected text in the document 
text by choosing a look for the selected text from the Quick Styles gallery on 
the Home tab. You can also format text directly by using the other controls on 
the Home tab. 

Most controls offer a choice of using the look from the current theme or using 
a format that you specify directly. To change the overall look of your document, 
choose new Theme elements on the Page Layout tab. To change the looks 
available in the Quick Style gallery, use the Change Current Quick Style Set 
command. Both the Themes gallery and the Quick Styles gallery provide reset 
commands so that you can always restore the look of your document to the 
original contained in your current template. On the Insert tab, the galleries 
include items that are designed to coordinate with the overall look of your 
document.  

Referencing  
There are several reasons why you need to use the HR system, including 
showing your sources, demonstrating that you have read widely on the topic 
and providing proof for claims. Most importantly it helps your tutor to identify 
which parts of the work are your original writing, which come from other sources 
and which portions have been inspired by other authors. By omitting relevant 
references to a text, you are passing off the work of others as your own i.e. 
plagiarism. 

How to reference 
Learning how to reference is straightforward, as you simply must follow a 
specific process for each reference. We have provided templates on the most 
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commonly used sources of information at the end of this section. Referencing 
can be time consuming if you don’t keep a list of your sources, so you may 
wish to use the appropriate section in your Portfolio to list all references that 
you use when researching and writing your assignment.  

To reference a source, you need to follow two steps: 

1. Intertextual Reference - Place a reference to the source in the body of 
the text or assignment. 

2. Reference List – Add your reference to your reference list at the end of 
your assignment. 

Intertextual references 
When should I use an Intertextual Reference? 

You should use an intertextual reference in one of the following circumstances: 

➢ You have made a factual statement. 
➢ You have referred to someone else’s work, theory, concept or idea. 
➢ You have used an indirect or direct quotation. 
➢ You have discussed, paraphrased, inferred, or otherwise alluded to 

someone else’s work. 

How do I make an Intertextual Reference? 

An intertextual reference requires, at a minimum, the author’s surname name, 
date of publication and page number, if known. Depending on how you have 
presented the information requiring the reference there are several options on 
the use of the reference. Two examples are seen below. 

“In addition, by comparison of gender, life expectancy is higher for women than for men almost everywhere 

in whole world (Kalan 2002, PP.45).” 

 

“According to Kalban (2002, PP.45), “Today, males have greater mortality than females throughout the world.” 

You can see that when you have used the authors name directly in the text, 
you simply need to use the publication date and page. If, however, the name 
does not arise naturally in the text, you will need to include it in the reference.  

How do I include reference if there are multiple authors? 

If you are referencing multiple authors from separate sources, they must be 
referenced individually, in the manner explained above. If you are referencing 
multiple authors from the same source, then you need to do one of two things. 

If there are 2 or 3 authors, you need to reference all their surnames, as above. 
If there are 4 or more authors, then you need to use the phrase “et al.” which 
means and others in Latin. For example: 

“However, research by Wallace et al. suggests that this trend may be reversing (2009, PP.42)” 

“Recent research suggests that this trend may be reversing. (Wallace et al. 2009 PP.45)” 
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“However, Wallace et al. state that “there is reason to believe that this trend will not continue and is in the 
process of a reversal” (2009 PP.45) 

What if I can’t identify the author, or it is a corporate author? 

By corporate author, we mean that there is no individual author, which is 
common for works published by a large organisation or governmental bodies, 
such as the NHS and BBC. In this case, you may use the abbreviation for the 
organisation in the reference, provided that you have previously used the full 
title of the organisation. You then enter the date as you would for an individual 
author. 

What if the source is a website, without a clear author?  

In this case, you need to establish the ownership of the website. For example, 
if you were to quote from the OxfordCollege.ac website, you could see that the 
copyright is claimed by Oxford Learning College in 2014. Note that websites 
have special requirements when adding them to the reference list. 

 

Figure 3 - One method for locating the owner of a website. 

What if the source is cited by another author? 

You may encounter references that are cited in another author’s work that you 
wish to include. While it is preferable that you read the original authors work, 
you may reference it in the following way. 

“Williams suggests that although the trend may be subject to fluctuations, it has remained consistent over the 

last 10 years (2007 cited in Jones, 2009, p.99) 

Reference list 
At the end of your assignment, you need to build a reference list. It will save 
you time and energy to build this list as you add references, rather than trying 
to build it as you work.  

Your reference list should be in alphabetical order. If you have used multiple 
sources from the same author, or authors that share the same name, place 
them in chronological order.  You can see a sample of a reference list entry 
below, which has been broken down into its components. 

Bloggs, J. 2012. How to build a reference list. Oxford: Generic Press 
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Websites need to have additional information added. You must follow the same 
conventions as a normal reference, but you need to add a link to the page in 
question and include the date on which it was accessed. You should also keep 
a screenshot of the page if possible, in case it is removed or updated. 

Reference images 
When referencing images, you need to include the photographer/artist, year in 
which it was created, its medium and its location. Please see the template 
below for an example. 

Reference templates 
Single Author 

Bloggs, J. 2012. How to build a reference list. Oxford: Generic Press 

Multiple Authors 

Bloggs, J. and Doe, J.J. 2013. How to build a reference list, The ultimate guide 2nd Ed. Cambridge: One Up 

Press 

Website 

Oxford College, 2014. Top tips for using the internet for research. [Online] Available at: < 

http://www.oxfordcollege.ac/news/top-tips-using-internet-research> [Accessed 11 July 2014] 

Image (Online) 

Brooke, B. 2013. Orange Eyes [Electronic print] Available at: 

<https://www.flickr.com/photos/89367001@N08/9385598696/> [Accessed 11 July 2014] 

Image 

Evans, R. 2014. A street image [Photograph] (London, Tate Gallery) 
 

Proofreading 
You should always proofread your assignment before you upload it to your 
tutor, as once uploaded the work cannot be retrieved. Proofreading ensures 
that you don’t make silly mistakes that will negatively impact your work. It also 
ensures that you have a chance to review your work and ensure that it is well 
written. 

If possible, leave the assignment alone for 24-48 hours before proofreading, 
as you will find that more errors can be spotted this way. Ideally, have your 
friends or family read it for you. Be wary about giving a copy to other students. 
You may have the best intentions but if they use your work you may find 
yourself in trouble. 

 

 

 

 

A note on Assignment/Essay writing services 

You may be tempted to use one of many online Assignment/Essay writing 
services to complete your assignment/essay for you. These sites will at best, 
generate an assignment that is unlikely to be suited to your study and at 
worst will send you a plagiarised assignment. 

All assignments are electronically scanned before being reviewed by your 
assessor. Plagiarised content will be found.  

Do not use assignment/essay writing services! 

http://www.oxfordcollege.ac/news/top-tips-using-internet-research
https://www.flickr.com/photos/89367001@N08/9385598696/
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Plagiarism 

Plagiarism is the act of passing off the work of another author as your own and 
if you are guilty of it, you will be liable to severe penalties, including but not 
limited to,  

Avoiding plagiarism 

Plagiarism can be intentional or unintentional, but by its very nature it is 
extremely hard to differentiate between a mistake made in good faith and overt 
plagiarism. Students are therefore advised to take a great deal of care with 
references. 

In addition, before submitting work, you are required to make a declaration that 
the work is your own, making a false declaration is classed as ´malpractice´ 
which can also result in dismissal from the course. 

Students can make use of a range of Anti-Plagiarism software to check their 
work before submission, but the single best way to avoid a penalty is to be 
honest, write your own work and ensure that you carefully reference all sources 
of information that you have used. As a general rule, you should expect less 
than 10% of your work to consist of quotes or any other use of other people’s 
words. In some disciplines, such as Law, there is often a necessity to use 
greater amounts of direct quotations, this is expected and only becomes a 
problem if referencing is inaccurate.  

Uploading your assignment 

When you have completed your assignment, you will need to upload it to your 
tutor/assessor. To do this, you need to log into Campus. Once logged in, you 
should click on the upload assignments link and click on your course. From 
there you will be asked to click a button, indicating that you are uploading your 
own work and that you are aware of the penalties of uploading plagiarised 
content. You will then need to click the browse button to locate your 
assignment.  

When you are uploading, you should receive a message and asked to confirm 
you have read this message before you are able to upload.  Make sure you 
read and understand the message before uploading. If you find that you do not 
receive this message please report this immediately to Student Services. 

If you accidentally upload an assignment in the wrong unit slot 
Please contact student services as soon as possible, using the Ask a question 
link. 
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Chapter 7: Feedback  

Your Tutor/Assessor will mark your assignment and upload it to campus. You 
will receive an email notification when it is complete. You can log into campus 
to download your assignment, check your grade, and review your feedback. 

A breakdown of the available grades and what to do when you get them can 
be found below. 

Pass - A pass grade is the standard passing grade and indicates that you have 
met all the requirements needed to pass the unit.  

Referral/Fail – If the pass criteria are not met for any element, the complete 
assignment will be referred.  

If you receive this grade and are allowed to resubmit a second time, you must 
study and act upon any advice given by your tutor in the feedback. Your tutor 
will specify the areas of weakness and offer some advice on how to rectify 
these weaknesses e.g. you need to evaluate not simply describe; answer is 
not focused on the question.  

Understanding your tutor’s feedback 

When you log into your account, having received an email notification you 
should be able to see a matrix – here is a snap shot of what it is likely to reflect: 

 

1.1  

 

 

1.3  

 

 

NOTE: If there is a criterion listed which has not appeared in your assignment 
(for example 1.3 in unit 1) then your tutor will have put in N/A. 

 

Feedback from your tutor is vital to improving your overall grades and for 
progression through the course. Therefore, along with this matrix you will 
receive more detailed feedback with comments made in your assignments.  If 
you don’t receive these you must inform your tutor immediately as we would 
not want anything problem with your progress.  It is your responsibility to make 

Met – As part of Task 1, in the third paragraph the learner has clearly 
outlined three different types of business transactions and explained each 
one. 

Not Met – The learner is required to evaluate two approaches to assessing 
risk. Only one approach has been included, and it has been described, not 
evaluated.  
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sure you study the feedback and take note of what is being recommended.  If 
there is anything you are not sure of please contact your tutor. 

What you should expect to see amongst the various forms of feedback 
We expect our tutors to be as informative as possible to students, without 
actually providing them with direct answers.  Awarding Bodies would not want 
our tutors or anyone else to provide direct answers to students as the learning 
and development belongs to the student. 

➢ Rationale for grade awarded – This explains the reasoning behind the 
grade awarded. 

➢ Strengths and positive aspects of the work submitted – this explains 
what you did well in your assignment. You should study this area 
carefully to incorporate these points into your next assignment. 

➢ Weaker areas of the work submitted – This explains where your work 
needs improvement. By understanding your weaknesses, you can work 
to resolve them to ensure your continuous success. 

➢ General guidance – This is intended to give you a general overview on 
how to improve and develop your work. 

 

 

  



Level 2 and Level 3 ACCREDITED DIPLOMA STUDENT HANDBOOK 

June 1, 2017, v2 

 
 

 

Page 25 of 28 
 

 

Chapter 8: If you have issues with your course 

For day to day queries with your College account, please contact Student 
Services via the on-line messaging system or via email. 

Any queries relating to the academic content of your course please liaise  
directly with your tutor via your on-line messaging system. 
 

Errors in materials 

Oxford College are continually reviewing the materials provided to students to 
stay in line with either trends of the particular topic or with Awarding Bodies.  

If, however, on the very rare occasion, you find what appears could be a 
mistake, we would really appreciate it if you could let us know. 

If you find something that appears to be a mistake, such as a spelling, general 
grammar, punctuation or a formatting mistake, please send an email to the 
Student Services team, along with a screen shot that indicates where there 
appears to be an error. 

If what appears to be an error is academic, eg an out of date fact, a 
miscalculation in your mathematics course material, or a wrong formula in a 
science course material or simply something doesn’t appear to be explained 
clearly, please contact your tutor directly via the messaging system.  

Feedback from students is always welcome for continuous improvement. 

 

Appeals on feedback from your tutor 

Programmes are delivered by an online system and therefore processes are in 
place to ensure that assessment is rigorous but flexible and fair to 
accommodate the needs of all involved. In addition, it is important within 
distance learning delivery to maintain a student-centred approach and consider 
the difficulties with meeting the learning preferences of students within a virtual 
learning platform which makes facilitation of learning more complex that via a 
traditional model. 

With this ethos in mind the assessment process allows for considerable 
flexibility yet offers security of process in a timely and professional assessment 
and feedback process. Assessment is carried out by qualified tutors and 
verified to ensure accuracy and consistency and that we are maintaining the 
integrity of the level of course you are studying. 

The system is highly effective and reliable, being endorsed by awarding bodies 
such as Edexcel/ATHE/CIE and the ABC National Award Organisation. 

Although Oxford Online College are confident in the assessment process, it is 
acknowledged that differences of opinion may arise and errors are possible 
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even in the most rigorous system. On return of an assignment, if you have any 
queries with regards to the feedback or grades you receive, you should contact 
your tutor who will be happy to offer further explanation or guidance. If your 
concern continues, further verification will take place.  The result of this further 
verification will be final. 

Student Complaints Procedure 

The College values greatly the views of its students. It aims, therefore, to 

manage complaints in a way that is sensitive to the needs of each specific 

case, and supportive of the College’s overall ethos.  

 

There are a number of informal channels through which is it hoped that most 

problems can be resolved.  These have been explained earlier. If, however, 

you need to pursue a complaint formally after attempting to resolve your issue 

via the informal channels, you can be sure that the College will treat it seriously 

and impartially, on the basis set out in this document. 

 

Advice on how to use the complaints procedure is available from a variety of 

sources, but in the first instance students are encouraged to contact the 

Student Services Team, by sending an email to contact@oxfordcollege.ac 

 

What complaints can be considered? 

1. Grounds for complaint (after informal attempts) might include: 

• Dissatisfaction with standards of academic provision (for example, 

the content and structure; resources and facilities; arrangements 

for assessment and information provided to you about your 

course). 

• Dissatisfaction with the quality of supervision and tuition. 

• Failure to meet obligations promised to you by the College. 

• Persistent deficiencies in standards of services you have been 

promised. 

• Harassment, bullying and victimisation by College 

representatives. 

 

2. Generally, complaints are most easily resolved if they are raised at the 

time the problem first occurs and with the person/s directly involved. 

Often, students will be able to resolve their issue, simply by discussing 

it with a Student Advisor or with their personal tutor. 

mailto:contact@oxfordcollege.ac
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3. If students cannot, or feel unable to, resolve concerns in this way, they 

can put their complaint in by completing a complaint form available 

from the student services team. The Academic Director, or a nominee, 

will seek to provide them with a response to their complaint within 21 

working days. 

4. Once your complaints form has been received, your case will be 

investigated and a full report presented to the Academic Director for 

consideration.  

5. Non-completion of this form will mean a complaint is not investigated. 

6. Refunds on the purchase of your course are available only if claimed 

within the first 14 days of enrolling. 
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Chapter 9: Special considerations and reasonable 
adjustments  

Oxford Learning College recognise disabilities are of a diverse nature and we 
do not tolerate discrimination on the basis of disability.  We allow fair access to 
our courses for all students. 

Equal opportunities and diversity categories include age, disability, gender 
reassignment, sexual orientation, marriage and civil partnerships, national 
origin, ethnicity, religion or belief, pregnancy and maternity.  

All candidates have an equal opportunity to demonstrate their knowledge, skills 
or understanding to the level of attainment required to enrol and succeed. 
Barriers to entry and continuous learning via on-line are removed where 
possible.  

However, in terms of sensory disability the responsibility lies with the student 
to make appropriate arrangements necessary to progress with their learning. 
Unfortunately, the college does not provide equipment necessary for students 
with visual difficulties. 

Students who suffer with health during their course are provided with support 
upon medical reports from doctors, psychiatrists and other specialists.  The 
College, wherever the Awarding Bodies will allow, will provide extension to 
programmes as requested.  Individual student tutors are made aware, without 
disclosing confidentiality, of the problems their student may be experiencing. 


